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Here	is	an	easy	way	to	help	you	to	toggle	the	outline	symbols	between	showing	and	hiding.	This	hide	and	display	shortcut	is	ctrl	+	8.	Where	the	8	is	only	using	the	key	under	the	function	keys,	not	the	key	in	the	Num	keypad.	Active	the	worksheet	which	contains	the	outline	symbols,	then	press	ctrl	+	8	keys	repeatedly	to	toggle	the	outline	symbols
between	hiding	and	displaying.	Note:	with	this	shortcut	keys,	you	can	only	show	or	hide	the	outline	symbols	in	the	active	sheet,	if	you	want	to	apply	it	to	the	whole	workbook,	this	way	will	not	work.	Show	or	hide	outline	symbols	with	Excel	Options	In	the	Excel	Options	dialog	box,	you	can	turn	the	outline	symbols	on	and	off	with	clicks.	Please	do	as
follows:	1.	Open	the	Excel	Options	dialog	box	by	clicking	File>	Options	in	Excel	2010/2013.	(	In	Excel	2007,	click	Office	button.)	2.	In	the	Excel	Options	dialog	box,	click	Advanced,	and	go	to	Display	options	for	this	worksheet	section,	specify	the	worksheet	that	you	want	to	show	or	hide	the	outline	symbols	from	the	drop	down	list,	then	check	or
uncheck	Show	outline	symbols	if	an	outline	is	applied	as	you	need	to	show	or	hide	the	outline	symbols.	3.	Then	click	OK,	the	outline	symbols	in	the	specified	worksheet	will	be	hidden	or	displayed	at	once.	Show	or	hide	outline	symbols	with	Excel	Options	The	above	two	methods	only	are	applied	to	the	specific	worksheet,	but	if	you	want	to	show	or	hide
the	outline	symbols	in	the	whole	workbook,	you	just	repeat	the	way	one	by	one.	But	if	you	have	Kutools	for	Excel’s	View	Options	utility,	you	can	quickly	toggle	the	outline	symbols	between	hiding	and	showing	either	in	a	worksheet	or	a	workbook.	After	installing	Kutools	for	Excel,	please	do	as	below:(Free	Download	Kutools	for	Excel	Now!)	1.	Click
Kutools	>	Show	/	Hide	>	View	Options,	see	screenshot:	2.	In	the	View	Options	dialog	box,	under	the	Window	options	section,	check	or	uncheck	the	Outline	symbols	to	show	or	hide	the	outline	symbols.	If	you	want	to	apply	this	function	to	the	whole	workbook,	you	can	click	Apply	to	all	sheets	button	at	the	bottom	of	the	dialog	box.	See	screenshot:	3.
Then	click	OK	to	finish	this	option.	The	View	Options	tool	makes	it	possible	to	show	or	hide	most	of	Microsoft	Excel	settings	quickly,	such	as	Inner	Tabs,	Formula	Bar,	Status	Bar,	Windows	in	Taskbar,	Gridlines,	Page	Breaks,	Display	Zeros,	Vertical	Scrollbar,	Horizontal	Scrollbar,	Sheet	Tabs,	…	etc.	It	will	save	your	time	in	looking	for	these	setting
when	you	need	to	show	or	hide	them.			Show	or	Hide	Outline	Symbol	Tip.If	you	want	to	quickly	show	or	hide	multiple	sheets	across	workbooks,	please	try	to	use	the	Kutools	for	Excel’s	Hide/Unhide	Workbooks	and	Sheets	as	shown	in	the	following	screenshot.	It’s	full	function	without	limitation	in	60	days,	please	download	and	have	a	free	trial	now.	No
ratings	yet.	Be	the	first	to	rate!	Full	PDF	PackageDownload	Full	PDF	PackageThis	PaperA	short	summary	of	this	paper1	Full	PDF	related	to	this	paperDownloadPDF	Pack	Home	➜	Excel	Keyboard	Shortcuts	Written	by	Puneet	for	Excel	2007,	Excel	2010,	Excel	2013,	Excel	2016,	Excel	2019	Knowing	and	using	Keyboard	Shortcuts	while	using	Excel	is
one	of	those	Basic	Excel	Skills	that	can	help	you	save	a	ton	of	time	every	day.	There	are	more	than	500	keyboard	shortcuts	that	you	can	use	in	Excel	but	the	problem	is	not	all	of	those	can	be	helpful	for	you.	That’s	why	I	have	listed	only	the	82	most	important	keyboard	shortcuts	that	you	can	learn	and	use	easily.	If	somehow	you	are	not	able	to	find	a
keyboard	shortcut	for	the	option	that	you	use	frequently	in	your	work,	you	can	use	the	following	method	to	find	it.	Here’s	the	tip:	When	you	press	the	ALT​	key	Excel	shows	you	the	keys	that	you	can	use	to	open	the	tab	from	the	ribbon.	And	when	you	press	a	key	for	a	particular	tab	to	open	it	further	shows	you	the	keys	to	open	the	options	that	you	have
on	that	tab,	so	one	for	further	drop-downs.	Super	Tips	Replace	your	10	most	used	options	with	shortcuts.Make	your	fingers	learn	the	shortcut	keys.	Download	the	Cheat	Sheet	(PDF)	Basic	Keys	KeyDescriptionControl	+	Up	Arrowmove	to	the	top	endControl	+	Down	Arrowmove	to	the	down	endControl	+	Right	Arrowmove	to	the	right	endControl	+	Left
Arrowmove	to	the	left	endControl	+	CcopyControl	+	VpasteControl	+	XcutControl	+	SsaveControl	+	PprintControl	+	F4save	asControl	+	Zundo	the	last	actionControl	+	Yredo	the	last	actionControl	+	Aselect	allControl	+	Spacebarselect	entire	columnShift	+	Spacebarselect	entire	rowDeletedeleteF2edit	cellEscclose	edit	modeF1helpMenu
Buttonright-click	menu	Formatting	Keys	KeysDescriptionCtrl	+	BboldCtrl	+	IitalicCtrl	+	UunderlineCtrl	+	!open	format	menuCtrl	+	Shift	+	@format	as	time	valueCtrl	+	Shift	+	#format	as	a	dateCtrl	+	Shift	+	$format	as	currencyCtrl	+	Shift	+	%format	as	percentageAlt	→	H	→	O	→	I	/	Aadjust	cell	width	to	contentAlt	→	H	→	B	→	Aapply	borderAlt	H	F
Cchange	font	colorAlt	H	Hchange	cell	colorAlt	H	A	Calign	text	to	the	centerAlt	H	M	Cmerge	cellAlt	H	Wwrap	textAlt	H	F	Fchange	font	styleAlt	H	F	Schange	font	sizeAlt	H	L	Nadd	conditional	formattingAlt	H	Tformat	as	tableAlt	H	Jstyle	cell	Insert	&	Layout	Keys	KeysDescriptionAlt	N	Vinsert	pivot	tableAlt	N	Tinsert	tableAlt	N	Pinsert	pictureAlt	N	S
Hinsert	shapeAlt	N	S	Cinsert	chartsAlt	N	Iinsert	hyperlinkAlt	N	Xinsert	text	boxAlt	N	Jinsert	objectAlt	N	Uinsert	symbolAlt	N	Hinsert	header	&	footerAlt	N	Z	Kopen	sparklinesAlt	W	V	Fhide/unhide	formula	barAlt	W	V	Hhide/unhide	headingAlt	W	V	Ghide/unhide	gridlinesAlt	W	Q	Cchange	zoomAlt	W	F	Ffreeze	paneAlt	W	F	Ipage	break	viewAlt	W	F
Ccustom	viewAlt	W	F	Ppage	layout	viewAlt	W	Aarrange	windows	Functions	and	Data	Shortcuts	KeysShift	+	F3insert	functionAlt	M	Rrecently	used	functionsAlt	M	Ifinancial	functionsAlt	M	Llogical	functionsAlt	M	Ttext	functionsAlt	M	Edate	and	time	functionsAlt	M	Olookup	functionsAlt	M	Gmath	and	trig	functionsAlt	M	Qmore	functionsAlt	+	=auto
sumAlt	M	Nname	managerAlt	D	F	Fadd	filtersAlt	A	V	Vinsert	data	validationAlt	A	Mremove	duplicatesAlt	A	R	Arefresh	allAlt	A	Eopen	text	to	columnAlt	A	Ggroup	rows	and	columnsAlt	A	Uungroup	rows	and	columnsAlt	A	Badd	subtotalAlt	A	S	Sopen	sort	My	Favorite	Keyboard	Shortcuts	KeyAlt	H	O	Rrename	a	worksheetAlt	+	F1insert	the	default	chart
More	Tutorials	for	YOU	Background	image	is	also	known	as	Watermark.	Microsoft	Excel	allows	you	to	add	Background	image,	logo,	and	background	colors	in	your	document	to	make	the	document	more	attractive,	beautiful,	and	eye-catching.	Note:	In	a	Microsoft	Excel	document,	you	can	not	add	a	background	image	to	multiple	Microsoft	Excel
documents	at	once.	Methods	to	set	a	Background	image	Follow	the	below	methods	to	set	background	in	Excel	-	Method	1:	Add	background	in	Excel	using	Page	Layout	tab	Steps	to	Add	background	in	Excel	There	are	the	following	steps	to	Add	background	in	Excel	-	Note:	Using	the	below	steps,	you	can	set	background	images	in	Microsoft	Excel	2007,
2010,	2013,	and	2019.	Step	1:	Open	a	new	Microsoft	Excel	document	(File	->	New	->	Blank	document	->	Create)	or	an	existing	Microsoft	Excel	document	(File	->	Open	->	Browse	document	location	->	Open	button)	in	which	you	wish	to	add	the	background.	Step	2:	Click	on	the	Page	Layout	tab	on	the	ribbon.	Click	on	the	Background	next	to	the
Breaks	option	in	the	Page	Setup	section.	See	the	screenshot	given	below.	Note:	In	Microsoft	2003,	click	on	the	Format	->	Sheet	->	Background.	Step	3:	A	small	Sheet	Background	dialog	box	will	appear	on	the	spreadsheet.	Browse	the	Background	image	that	you	want	to	set	and	click	on	the	Insert	button	at	the	bottom	of	the	dialog	box,	as	shown	in	the
below	screenshot.	Now,	the	screenshot	below	shows	that	your	desired	background	image	will	appear	in	the	Microsoft	Excel	document.	Method	2:	Add	a	background	image	in	Microsoft	Excel	using	the	keyboard	shortcut	keys	Microsoft	Excel	also	allows	us	to	Add	or	set	a	background	image	quickly	and	easily	using	the	keyboard	shortcut	keys.	Steps	to
set	background	A	list	of	below	mentions	steps	shows	that	how	to	set	a	background	image	in	a	Microsoft	Excel	document	-	Step	1:	Double-click	on	the	Microsoft	Excel	icon	to	open	a	Microsoft	Excel	document.	Step	2:	Open	a	new	or	an	existing	Microsoft	Excel	document.	Click	on	the	File	->	New	->	Blank	document	->	Creat	to	Open	a	new	blank
Microsoft	Excel	document.	Click	on	the	File	->	Open	->	Browse	document	location	->	Open	button	to	open	an	existing	Microsoft	Excel	document.	Note:	In	our	case,	we	are	going	to	open	an	existing	Microsoft	Excel	document.	Step	3:	Press	the	Alt	+	P	+	G	keys	together	from	the	keyboard	to	open	the	Sheet	Background	dialog	box.	Browse	the
background	that	you	want	to	be	set	on	the	Excel	document	and	click	on	the	Insert	button	at	the	bottom	of	the	Sheet	Background	dialog	box.	Step	4:	Now,	you	can	see	that	your	preferred	background	is	added	to	the	Microsoft	Excel	document.	Step	5:	Go	to	the	Page	Layout	tab	on	the	ribbon	and	untick	the	checkbox	associated	with	the	View	in	the
Sheet	Options	group	to	remove	gridlines	from	the	background	and	makes	background	more	attractive.	See	the	screenshot	given	below.	Method	3:	Add	a	background	with	the	Fill	color	tool	Microsoft	Excel	also	allows	you	to	add	a	background	with	a	fill	color	tool.	In	this	method,	a	Fill	color	picker	is	used	to	add	the	backgroud	color.	Steps	to	add	a
background	in	Microsoft	Excel	document	A	list	of	steps	to	add	a	background	in	Microsoft	Excel	document	given	below	-	Step	1:	Open	a	new	or	an	existing	Microsoft	Excel	document	in	which	you	want	to	add	a	background	with	the	fill	color	tool.	Step	2:	Press	the	Ctrl+A	keys	from	the	keyboard	to	select	the	whole	Microsoft	Excel	document.	Step	3:	At
the	top	left	corner	of	the	Microsoft	Excel	document,	click	on	the	vertical	arrow	under	the	cell	selection	menu	as	shown	below	given	screenshot.	Step	4:	Now,	click	on	the	Home	tab	and	click	on	the	Fill	color	drop-down	icon	under	the	Font	group.	A	color	picker	will	appear	on	the	document.	Select	the	color	that	you	want	to	apply	as	a	background	on
your	Excel	document.	The	screenshot	below	shows	that	your	selected	background	color	is	applied	to	the	Microsoft	Excel	document.	Method	4:	Add	printable	background	in	Excel	Microsoft	Excel	helps	you	to	add	the	printable	background	images	in	the	Microsoft	Excel	document	with	its	Insert	Watermark	feature.	This	is	quickest	the	method	to	insert
the	background	image	or	text	Watermark	in	the	spreadsheet	based	on	your	requirement.	Steps	to	add	a	printable	background	in	Excel	A	list	of	steps	to	add	a	printable	background	in	Excel	is	discussed	below	-	Step	1:	Open	a	new	or	an	existing	Microsoft	Excel	spreadsheet	in	which	you	want	to	add	a	printable	background.	Step	2:	Click	on	the	Insert
tab	next	to	the	Home	tab	and	then	click	on	the	Shapes	drop-down	icon	in	the	illustrations	group.	A	list	of	shapes	will	appear	on	the	document,	select	a	rectangle	shape,	see	the	below	screenshot.	Step	3:	Draw	a	shape	in	your	spreadsheet	as	large	as	you	required.	Step	4:	The	Drawing	Tools	is	active	and	appears	at	the	top	of	the	spreadsheet.	Click	on
the	Shape	Fill	button,	and	select	the	color	that	you	want	to	fill	in	the	shape.	Note:	In	our	case,	we	fill	the	shape	with	the	white	color.	Step	5:	Now,	click	on	the	Shape	Outline	option.	A	color	picker	will	appear	on	the	screen	in	which	select	your	desired	outline	color	that	you	want	to	apply	to	the	shape.	Step	6:	Right-click	on	the	shape,	a	small	dialog	box
pops	up	with	the	list	of	options.	Click	on	the	Format	Shape	option.	Step	7:	A	Format	Picture	dialog	box	will	appear	on	the	screen	in	which	do	the	following	-	Click	on	the	Fill	option	from	the	left	pane.	Click	on	the	Picture	or	texture	fill	radio	button.	Click	on	the	File	button	in	the	Insert	from:	section	to	browse	the	image	that	you	want	to	use	as	a
background	image.	Tick	on	the	Tile	picture	as	texture	checkbox.	Add	Transparency	based	on	your	requirement.	Now,	click	on	the	close	button	at	the	bottom	of	the	Format	Picture	dialog	box.	The	screenshot	below	shows	that	your	desired	background	is	set	to	the	Microsoft	Excel	document.	Next	TopicHow	to	use	COUNTIF	function	in	Excel
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